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Website Designer (A quick Overview) 
 

The Website Designer lets you… 
 
 

q Build your own organization’s website. There is no website to host, no passwords to remember, no special 
software to load. 
 

q Put any report or view that you would usually print to paper onto your own website.  Plus, put any other 
information you wish to appear on your website.  
 

q Build your website offline and update changes only when you are ready.  
 

In summary, the Website Designer provides a “turnkey” solution for placing all your organization’s pertinent 
information on the web. 

 
 
 
 
 
  

 Why do I need a Website?   
The question really should be, how can you do without a website?    
 
A website lets you…. 

q Provide instant updated information to all your members. Member directories, schedules, tee times, pairings, 
results, leader boards, event details, directions, online sign-ups, event cancellations, etc. 

q Information is available 24 hours a day. 
q Information can be accessed from any computer anywhere. 

 
Your benefit… 

q Saves a tremendous amount of time. Example: Rain is predicted. Will the event be cancelled? How many phone 
calls will you get? Post an event cancellation notice on your website’s homepage.   

q Saves money. Example: Do you send out costly and time consuming mailings or emails to update information, 
schedule, pairings, results, etc? Your website is open 24/7. No need to print out endless copies of reports or send 
endless emails. Paper, postage, ink, etc, costs are zero. 

q Reduces errors. Example: A result sheet shows an incorrect score. A member will let you know. 
 
Members benefit… 

q Better informed. Information is just a few clicks away. 
q Members feel better. An informed membership feels included and well-serviced. They feel like they are not 

“bugging” you all the time. 
q Saves time. Members can get complete, updated information at their convenience. 

 
 
 
Bottom line, your website will streamline your operations and become your greatest asset. 
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 I can’t do it!  It’s too complicated. 
Yes you can! The “Website Designer” lets you quickly create your own website!  And you don’t have to be a web “guru” to 
do this!  What exactly does this mean? This means any “report” or “view”, you usually print to paper….can also be placed 
on your own website. Plus any other information you wish to show. Now anyone in your organization can see this 
information on the web at any time! 
 
Example: To put the following view on your website…   
 

 
Figure 1 – Sample View in the Tournament Manager 
 
 

1. Pull down the “Website” menu, and select “Save current View for display on website”. The 
following form appears.  
 

 
Figure 2 – List of your reports and views you want on the web.  
 
 

2. Type in the name you wish to use. In this case, the name: “Name Addresses and Phone Numbers”, was used. 
 

3. Click the [Save] button. This view can now be placed on your website. 
 
 
Tip:  Reports work exactly the same way. Simply display the report on the screen, pull down the “Website” menu, and 
select “Save current Report for display on website”, type in the report name and click [Save]. 
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Using the “Website Designer” 
 

 Overview 
The “Website Designer” lets you design exactly how your website will look. You choose what information will appear, its 
order, how reports and views will be displayed, etc.  To run the “Website Designer”, pull down the Website menu and 
select “Website Designer”.  Since this is probably the first time you’ve used the “Website Designer”, it probably looks 
like this: (nothing yet in it). 
 

 
Figure 3 - The “Website Designer” 
 
The “Website Designer” emulates how your site will look in a browser such as Microsoft Explorer, Netscape Navigator, 
etc. (A browser is what you use to view websites on the internet). On the left hand side is a list of menu items. On the right 
hand side is the page displayed when the menu item on the left is clicked. In Figure 3 above, the menu item 
“Announcement Page” is the highlighted menu item on the left, and the contents of the “Announcement Page” are 
displayed on the right. 
 
Tip: At anytime, click the [Preview Website] button to see what your website will look like in your browser. 
 

q Website Designer is quick to use. You do not even have to be connected to the internet in order to build your site, 
so you are not subjected to slow internet connections or having to be constantly online. Only when you are ready 
to “publish” (put your website on internet), do you have to connect to the internet. 
 

q Website Designer is flexible. You can change information in your website at any time. And your website can 
contain any number of pages.   

 
You use 5 basic “building block pages” to design your website:  

1. Spreadsheet Pages…shows any report, view, or text file.  You can even create custom sheets to show anything 
you wish. 

2. Menu List Pages…pages that list and link to any number of “spreadsheet pages”…reports, views, text or custom 
sheets. 

3. Announcement Pages…shows any type of text information you wish to display. 

4. Table Pages…shows any type information in a table format. 
5. Link Pages…allows you directly link to any page in your site, or any page on the internet (world wide web). 

 
These are discussed (with examples) in the next few pages. 



Website Designer Using the “Website Designer”  ••   4 

 
 

  Creating an Announcement page 
Announcement pages let you show any text you wish on a webpage. For example, you can use an “Announcement Page”  
to display: 
 

q A “Home” page with announcements. 
q League, club or association information. 
q Detail your rules, regulations and policies. 
q Signup information. 

q By-laws. 
q Etc… 
 

Example: Create a “Home” page for your website.   
 

1. Add a new “Announcement Page” to your menu items list. 
You probably already have an “Announcement Page” on your menu items list so this step is not required, but if 
not, to add a new page, pull down the “Menu” menu and select “Insert-Announcement page”.  A new 
announcement page will be added. Note: You can have any number of “Announcement pages” on your website. 
 

2. Rename the menu item to “Home”.   
Right-click on the menu item that says “Announcement Page”, and select “Rename Menu Item - 
Announcement Page” on the drop down menu. Type the Delete key to remove the text that is there and type 
in “Home”. Click [OK].  “Home” is now the name of this menu item. 
 

3. To add text in your “home” page, simply click anywhere on the right hand side and enter text on your page.  It 
may look something like this…. 
 

 
Figure 4 – Sample Announcement Page 
 
 

4. Click the [Preview Website] button at any time to see what it looks like in your browser. 
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 Creating a Menu List page 
 
Menu list pages lets you show any number of  “spreadsheet pages”…reports, views, text or custom sheets on your  
website.  
  
Example: Put a membership view on your website. 
 

1. Add a new “Menu List Page” to your menu items list. 
You probably already have a “Menu List Page” on your menu list. If not, to add a new menu item….pull down the 
“Menu” menu and select “Insert-Menu List of Spreadsheet pages”.   
 

2. Rename the menu item, “Membership”.   
Right-click on the menu item “Menu List Page”, and select “Rename Menu Item - Menu List Page” on the 
drop down menu. Type in “Membership” and click [OK]. “Membership” is now the name of this menu item. 
 

3. On the right, click the button which says [Click me to Add a spreadsheet page link]. The “Open 
report, view, or sheet” form will appear. 
 

4. Double-click the View named “Sample Name Addresses and Phone Numbers” to load this on the “Menu List 
Page”.  The screen may look something like Figure 5. 
 

 
Figure 5 – “Sample Name Addresses and Phone Numbers” report. 
 
Note: You can have any number of “Menu List pages” and each can contain up to 100 reports, views, sheets, etc.  
You can further customize how each sheet appears. Header and footer text can be added, titles can be altered, 
and fonts, colors, row and column sizes, text, etc can be fully customized. You can even insert graphics or text 
anywhere you wish. 

 
5. Click the [Preview Website] button to see what it looks like in your browser.  It may look something like figure 

6 below. 
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Figure 6 – “Sample Name Addresses and Phone Numbers” in your browser. 
 

 
 
 
 
 
 
 

 Creating a Table page 
Table pages let you show any type of information in a table format.  For example, you can use a “Table Page” to display: 
 

q Calendar of events page 
q Contact Us page 
q Trophy Room page 
q Links to other websites page 

q Charts 
q Etc… 
 

Plus, items in a table can even be linked to other pages in your website or any website in the world. 
 
Example: Create a “Favorite Links” page for your website.   
 

1. Add a new “Table Page” to your menu list. 
Pull down the “Menu” menu and select “Insert-Table page”.  Type “Favorite Links” as the menu item 
name and click [OK].  A new table page will be added. 
 

2. By default the table has 4 columns, but we only want 2 columns. To delete the 2 extra columns, pull down the 
“Table” menu and select “Delete”…”Column”.  Click [Yes] to verify delete.  Repeat, to delete the 2nd column. 
 

3. Click anywhere on the right hand side and enter text on your table. The table I created looks like this…. 
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Figure 7 – Sample Table Page in the Website Designer. 
 
Tip: To resize a column, click on the vertical line between column header numbers and drag line left or right. 
 
Tip: The above sample table includes links to other website pages. (A link is when you click an underlined item on 
a web page and are sent to another page).  To set a link, highlight the cell in the table you wish to specify a link 
for. Pull down the Table menu and select “HyperLink”. On the “Insert Hyperlink” form specify the page you 
wish to link to and click [OK]. 
 

4. Click the [Preview Website] button at any time to see what it looks like in your browser. 
 

 
Figure 8 – Sample Table Page in Internet Explorer Browser 
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 Creating a Link page 
Link pages let you create a menu item that links directly to any page in your website or any page on the internet. For 
example, if you already have a website you can set a direct link back to your “master” website…so it appears that this 
website is a seamless part of your “master” site. 
 
Example:  Create a direct link to our website (Software Systems for Golf).  Our website is www.golfsoftware.com. 
 

1. Add a new “Link Page” to your menu list. 
Pull down the “Menu” menu and select “Insert – Link page”.  A new link page will be added. 
 

2. Rename the menu item,  “Software Systems for Golf”.   
Right-click on the menu item that says “Link Page”, and select “Rename Menu Item - Link Page” on the 
drop down menu. Type in “Software System for Golf”.  
 

3. On the right hand side, click the button [Change the page or internet address to hyperlink to]. 
The “Insert Hyperlink” box will appear. 
 

4. In the box that says “Web Address:” type in  www.golfsoftware.com  and click [OK].  Your Website 
Designer may look something like this… 
 

 
Figure 9 – Link Page to www.golfsoftware.com 
 

5. Click the [Preview Website] button at any time to see what it looks like in your browser.  If you are 
connected to the internet, you will see the Software Systems for Golf website appear when you click the “Software 
Systems for Golf” menu item. 
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Creating a Spreadsheet page 
Spreadsheet pages are the ultimate in flexibility. You control everything...font type, font style, font size, row heights, 
column widths, text alignment, text color, and background colors. You can insert graphics and pictures and also insert 
hyper links to other pages or websites. You can even import excel files or text files into a custom sheet.  In fact, using 
spreadsheet pages you can build any type of page we’ve previously looked at….announcement pages, menu list pages, 
and table pages, with complete control. 
 

1. To add a new “Spreadsheet Page” to your menu list. 
Pull down the “Menu” menu and select “Insert – Spreadsheet page”. 
 

2. You are given the option to load an existing report or create a new sheet from scratch. 

 
 
 
I chose to create a blank sheet from scratch. See Figure 10 below. Notice the picture I inserted on the page.  This 
gives you a small sample of the types of pages you can create. The step by step details are beyond the scope of 
this quick overview. See the online “Website Designer” manual for details. Or just dive in. If you are familiar with 
using a spreadsheet program, the operation is very similar.  
 

 
Figure 10 – Sample custom spreadsheet page 
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Figure 11 – Sample custom sheet as it appears in your browser.  

 
 

 Publishing your website 
Your website is no good unless your members can access it. To put your website on the internet: 
 

1. Make sure you are connected to the internet. This is the only time you need to be connected to the internet. 
2. Pull down the File menu and select “Publish website to internet”.  Website Designer copies your 

website onto the internet (up to a web-server) so your membership can now view the website. 
 
 

 

 Telling others how to access your website. 
Simply tell your members to go to your website. But where is it?  To see… 
 

1. Click the [Website Info] button, on bottom left. 
2. The “Website info” from will appear. Look at “Your website address on the internet is…”.  This is the address of 

your website. 
3. Type it in your browser and click go. Voila! Your website will appear. 

 
 

 What Else 
This overview has given you a brief idea of what the Website Designer can do. These simple examples have just 
scratched the surface. Feel free to experiment. There is nothing you can do that cannot be “undone” or “changed”. To give 
you a better idea of Website Designer’s capabilities, take a look at a sample site created with the Website Designer.  It 
may give insights on different things you can do. 
 
Go to the following link: 
http://www.golfsoftware.com/products/wb/tmsample/index.html 
 
-OR- 
 
Pull down the Help menu and select “Help on the Web (FAQ, Videos, and Sample Sites)” 


